
RealtiWeb® Ontario Basic User Guide
This guide is for the basic tasks to open and complete a real estate deal.

Other guides available include:

Advanced User Guide
More advanced features like editing master documents and exporting to e-reg

Administrator User Guide
For Administrators of LDD RealtiWeb Accounts

Accounting Integration Guides
Setup and manage imports and exports to/from accounting packages, including PCLaw and CosmoLex

Title and Writ Search Guide
Use Teranet capabilities without leaving your RealtiWeb screens
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Main Screen
A�er logging in and selecting Ontario, you will be brought to the Main page of RealtiWeb. This is where
you will manage your files and see what is coming up.

File List
The Main page will show your file list. The Recent files will show the last 20 files you have viewed on
your computer. However, you can select Active files or Archived files across the bottom of the Files
portion of the screen to view all active or archived files, respectfully.

The Filter on the Files portion allows you to specifically search for a file, either by File No., Client
name, Reference Line, Closing Date, etc. To sort your files differently for the session only, click on the
column headings (such as File No. or PSM).

Note: PSM is an acronym in RealtiWeb, that is used for identifying the file type.
P: Purchase file
S: Sale file
M: Mortgage file

Later in the Docs Button and Master Documents Settings you will see P, S, M, PS, PM, SM, PSM. In
this context, the syntax is identifying the file types applicable to each document.

From the Main page you will see your firm’s files. This list can be customized by clicking the cog icon
Edit List.  Any change to the file list display will be reflected for all users.

Note: Changing the list view will change it for all users.

Calendar
The Calendar feature reminds you of important dates in the current week, day or month. Your account
administrator is able to setup what is shown here and if any reminders are sent out.  More about this
feature will be covered in the Issues button.

Inbox
The Inbox is how LawyerDoneDeal sends documents between LawyerDoneDeal users. If you are using
LDD WebDocumentRetrieval® your files will appear here.

Control Panel
These controls allow you to create or find a file. Find a File will open a popup with fields you can fill
out to search for your file.
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How to Create a File
There are 3 ways to create a file:

● File → Create New File (or you can click Create a New File in the Controls area)
● File → Create New File From Template
● File → Copy Existing File

For this training session, we will focus on creating a purchase file from Create New File.

File Creation Screen
A�er clicking Create a New File in the Controls panel, you will see a blank file.

It is recommended to complete all known fields, especially the following fields:

● Responsible Lawyer
● Firm Contact
● Title insurer using for the transaction
● Whether this is a new home being

purchased from a builder
● Purchasers
● Vendors

● Property Type
● Property Address
● Closing Date
● Contract Date
● Interim Closing Date (if applicable)
● Requisition Date
● Contract Price
● Deposits

Note: Screen content will vary depending on Deal Type and if it is a Condominium or Freehold.

To finish creating your file, you must enter a File # and Deal Type for the Continue button to appear.

If you indicate TitlePLUS is being used for the deal, a series of questions will appear above the
CONTRACT DETAILS section.

A�er entering information on this screen, click the Continue button. A new screen will appear with 6
buttons located at the top of the screen.

File Orientation
There are multiple buttons across the top of the file, as well as tabs depending on the selected button.
This will vary depending on the file type chosen. In this particular case we are focusing on a
Purchase transaction.

The buttons being covered in this guide are: Basic, Mortgages, Issues, Financial, and Docs.

If you want to return to the Main screen (where the file list is located), click Main (across the top of the
screen, beside Log Off).
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Databases
In RealtiWeb, majority of the databases are accessible with the database button beside the specific
field. You may add, edit and delete specific database entries on the account level, resulting in your
changes impacting other users at your firm. Alternatively, you can change data for that specific
RealtiWeb file and not update your firm’s database.

Field for Database Location

Firm Contact Basic → Basic Information

Conveyancer Basic → Basic Information

Fire Insurance Basic → Basic Information

City/Town Basic → Property and Legal Description

Condo Corp. Name Basic → Property and Legal Description

Condominium Contact Basic → Property and Legal Description

Other Side’s Lawyer Basic → Contract Details

Real Estate Broker Basic → Contract Details

Mortgage Lender Mortgages

Favourite Clauses Issues, Documents

Note: The fields Condo Corp. Name and Condominium Contact appear if the subject property is a
Condominium.

The majority of the databases across RealtiWeb have a database button, edit and clear buttons. You
are able to save your frequently used contacts and clauses to your firm’s account. This saves you time
later, when you are opening or updating a file.

For example, the Fire Insurance database is accessible through clicking the database button. Simply
click on a name to use that insurance agent. Alternatively, you may select the blue Edit or Copy link to
start editing the entry.

If the insurance agent you want is not in the database, you may add the insurance agent using the blue
Add link in the heading of the list of Insurance Agents.

Clicking the blue Add link will allow you to enter the new insurance agent details.

A�er entering the insurance agent details click the OK button to add the agent to the file.

Note: If you want to use the insurance agent in other files (current or future), click Update List to
add the agent to your firm’s list.
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Overwrite (Field turns Pink)
If a field is pink, it means the default text has been overwritten (meaning someone has manually typed
in the field). If you want to change the text back to the default (and thus any changes will be removed),
right click and select the Remove Overwrite option.

Working in Your File
Basic Button
The Basic button is the screen all files show a�er they are created (or a�er opening a file from your file
list).

Under the Basic button there are 5 tabs: Basic Information, Property and Legal Description,
Contract Details, Title Search, and Writ Search.

As information is entered into RealtiWeb, the system will be able to generate documents with the
appropriate information. Inserting as much information as possible throughout your file will save you
time.

Basic Information tab
The first tab, Basic Information is where the Transferee(s), Transferor(s), Firm Contact,
Conveyancer, Fire Insurance and other basic information are added to or edited in the file.

Some of the fields may have been completed during file creation, such as Transferee(s), Firm
Contact, etc. Complete any fields that have not been completed. The more information included in
your file, the more complete your documents will be throughout the transaction. You can always come
back and add it.

The edit button to the right of some fields allows you to edit the information in that database record,
for example a lawyer. Clicking on this button will open a screen that allows you to edit or enter this
information.

Adding Purchaser/Transferee
To add a new Transferee, click the edit button beside the Transferee(s) field.

This will open the Purchaser/Title Information popup. Fill in the information from the Agreement of
Purchase and Sale until you receive title instructions.

The On Title and As per Agreement checkboxes impact many of the documents in RealtiWeb.
Completing these checkboxes will assist the system in determining the appropriate signatures to use,
who to address various documents to, etc.

The Main Contact checkbox will show the client’s name on the Basic Information tab along with the
entered contact information. In addition, the Ongoing Relationship checkbox will activate clauses in
documents specific for when a client has a long-term relationship with the firm.
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The Entitled to Provincial LTT Refund checkbox will change how land transfer tax is calculated under
the Financial Button (this will be covered in more detail under the Financial Button section of this
guide). The Joint Declaration/Capacity Statement checkbox will add another data field to add the
appropriate joint declaration/capacity of the purchasers.

As information is gathered regarding title you can enter information at a later time. Click on the close
button when you have finished entering all required information.

Adding Seller/Transferor
Adding a transferor is similar to adding a transferee. From the Basic Information tab, click the edit
button beside the Transferor(s) field. This will open the Vendor/Transferor Information popup,
which looks similar to the Purchaser/Title Information popup. Complete the information you know
about the transferor.

Adding Client Identification Verification Information
A�er adding your client(s) to the file, you can add their identification into the system by clicking the
Client ID button. For the purposes of this guide a Purchase file is used, and therefore the Client ID
button is next to the edit button for the Transferee(s).

A�er clicking the Client ID button the Identification Verification Information popup will appear. This
popup lists all the individuals listed in the file (signing officers, guarantor(s), etc) and the
transferee(s)/transferor(s)/mortgagor(s) listed in the file (both individuals and corporations),
depending on file type.

Follow these steps to add applicable identification for individuals into your file:
1. Enter the Occupation(s) for each person.
2. The Birth Date will pre-populate provided you have entered it under your client details.
3. Enter the Verification Date the individual’s identification was verified.
4. Where there is a mortgage in your transaction, there is the ability to use either the Single

Process Method or Dual Process Method for ID verification.
a. Single Process Method:

i. By default this method is already expanded.
ii. Enter the Type of Identification (use the database button to select commonly

used documents) and application information regarding the ID. If you want to
add more than two pieces of ID, click the Add New button to add more IDs.

b. Dual Process Method:
i. Click the plus icon ( ) beside the Dual Process Method to expand the

section.
ii. Use the database button underneath Identification Document to select

commonly used documents, and complete the applicable information
regarding the ID. If you want to add more than two pieces of ID, click the Add
New button to add more IDs.

If you have a corporation as a client, the Corporate Information section will show underneath the
Individual Information section. Enter in the applicable fields (for example Type of Entity, Reg #,
Type of Record referred to, and Source of Electronic Version) identifying the corporation.

At the top of the screen Documents are available for Client Identification Information. Create
Document - Bank Forms - Identification Verification Form - PDF will provide you with the Lenders
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specific document (if available). Create Document - Client Identification Information is a LDD source
document which you may use for your file if there is no Mortgage.

Adding Other Parties in the Real Property Transaction
Please refer to the Database section for completing Firm Contact, Conveyancer, and Fire Insurance.

Property and Legal Description tab
The following tab, Property and Legal Description is where you enter the subject property address,
type and legal description.

By clicking the edit button beside the City/Town field, a popup will open for information to be entered
regarding the costs of tax certificates, building and zoning reports, etc.

The City/Town field impacts other RealtiWeb features and fields, such as automatically selecting Land
Registry Office, Assessment Roll No., Condo Corp Names, Plan Numbers, and fields in the Legal
Description box.

Note: It is possible to bring in the property information from the Title Search tab, refer to the Title &
Writ Search User Guide (found in the Title Search tab).

The Property Type dropdown is important to complete. The field indicates to RealtiWeb if the subject
property is a freehold or condominium, and will impact what is displayed on each screen (similar to
how Purchase files are slightly different from Sale files).

Note: If you want to indicate a Parcel of Tied Land (POTL) for a freehold, checkoff the t/w Common
Elements? checkbox.

Contract Details tab
This tab includes all information pertaining to the Agreement of Purchase and Sale, with some overlap
from the previously completed tabs, such as Contract Date, Closing Date, Contract Price,
Transferee(s), and Transferor(s).

New or Resale Property
The radio button ‘Is this a new home purchased from a builder?’ will help the program to determine
what should be shown.

For example, if the home is being purchased from a builder, answering ‘yes’ will show all the important
fields pertaining to new homes, such as GST/HST rebate, TARION, etc.

If the subject property is not a new home (a.k.a. resale) then, a question regarding vacant land will
appear.

Real Estate Broker
Enter the real estate agent or broker using the database button. Complete the Real Estate
Commission information.
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Title Search and Writ Search tabs
The last two tabs (Title Search and Writ Search) are available to use, if you (or your firm) have a
Teranet Connect account. This is a subset of Teraview on the Web. You are able to search Land Titles
and bring the information into RealtiWeb.

Refer to the Teranet Connect Guide for set up, and the RealtiWeb Title Search Guide for training on
the Title Search (or Writ Search) tab. Both guides are accessible at the bottom of the page.

Mortgage Button
The Mortgage button is used to add new mortgages to the file. Existing mortgage on title are handled
via the Issues button.

Lender selection
The first field that should be completed when adding a mortgage is the Lender, using the database
button.

Note: The Lender that is selected affects what Type of Mortgage can be chosen.

The database button will open the Mortgage Lender Database.

The Mortgage Lender Database separates the lenders into two categories based on if the lender is a
confirmed TitlePLUS lender or not. Any lender listed under TitlePLUS Confirmed Lenders is a lender
who accepts TitlePLUS policies notwithstanding any absence of a reference to TitlePLUS title
insurance in their instructions. If the lender is not listed under TitlePLUS Confirmed Lenders then see
if it is listed under Other Lenders (or add it).

Click on the plus icon beside the name of the mortgage lender to expand the list of branches. The
branch name you are hovering over will be highlighted.

You have two options for adding a lender to your file: adding a new lender branch, or editing an
existing lender branch.

Method 1: Add a New Lender
Click on the blue Add… link under your selected lender to open the LawyerDoneDeal Web
Page Dialog box. Enter the mortgage lender branch information in accordance with the
instructions from the mortgage lender.

Click Save to add the branch to the firm’s database. If your entry is to create a duplicate of an
existing branch, click Save as New . This will create another entry with your amended
information.

The branch of the mortgage lender you added will be added to the list for that mortgage
lender.
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Method 2: Editing an Existing Branch in the Lender Database
If you want to edit a branch entry, click the blue pencil (beside the trash bin icon). This will
open the current branch information in a popup for editing.

Note: The blue trash bin icon will delete the branch entry from the Mortgage Lender
Database. Caution - this action is not recoverable.

The lender’s name and mortgage position will appear. Note: If you need to add more than 1 mortgage,
click the Add tab to include additional mortgages.

Select Type of Mortgage
RealtiWeb includes the capability to pre-populate some of the Charge Provisions and Schedules for
selected mortgage lenders (such as the big 5 banks), as well as bank forms such as request for funds
and report to lender.

Select from the list of mortgage lenders (for example, Bank of Montreal).

Select a Type of Mortgage by clicking on the database button to the right of the Type of Mortgage
field.

The Select Mortgage Type box opens. Click on the type of Charge/Mortgage in accordance with the
instructions from the mortgage lender.

The applicable Charge/Mortgage Provisions will be pre-populated (if available). Note that in this
example, the Interest Rate, Calculation Period, Standard Charge Terms, Insurance and additional
provision fields have been pre-populated.

Enter the rest of the mortgage details in accordance with the instructions from the mortgage lender.

Calculating Mortgage Advance
Click the edit button next to Mtg Adv $, to open up a blank window. Enter the applicable fees, and their
amounts. By default Debit is selected.

Click Set Advance to update the Mtg Adv field on the previous screen and close this window. If the
applicable fees are unknown, you may also type the Mtg Adv directly into the Mtg Adv field.

Add a Mortgage Schedule
To add a Charge/Mortgage Schedule, click on either Additional Terms or Click here to go to Lender
Schedules.

The LawyerDoneDeal™ Web Page Dialog box opens. Click on the Add button.

If there are available schedules, you are able to click on the database button to start selecting a
schedule from the list.

If the database button is not shown, then you will have to click on the text underneath the e-reg PDF
button, and either manually type or paste the schedule.
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The Select Mortgage Type box opens a popup. Click on the type of Charge/Mortgage in accordance
with the mortgage instructions. If you do not see the type of Charge/Mortgage required for your
transaction, then close the Select Mortgage Type box and add in manually.

The selected Schedule will appear on the screen.

Note: Any empty data fields (a.k.a. grey boxes) need to be completed. When possible RealtiWeb will
pull data into the data fields.

A�er entering the Charge/Mortgage provisions in accordance with the instructions from the mortgage
lender, click Close at the bottom of the Schedule.

The Schedule will be included with the e-reg™ export the Charge/Mortgage to e-reg.

Specifics for TitlePLUS® deal
If the file is a TitlePLUS deal, the question Is this Mortgage TP Insured? will be displayed.

If using TitlePLUS and the mortgage is TitlePLUS insured, check off the checkbox to indicate “yes”. The
checkbox will be checked off if you have indicated this deal is a TitlePLUS deal on the Basic
Information tab.

The TitlePLUS wallpaper will appear with TitlePLUS related questions and fields to be completed.

Issues Button
The Issues button has five tabs: Master Issues List, Inquiry Status, Requisition, Checklist, Report.

Master Issues List tab
The Masters Issues List tab is for you to add any action items or issues with the transaction. For the
purposes of this guide, we will be doing a non-TitlePLUS deal.

How to create an issue
There are two ways to add issues:

1. Manual entry
2. Title search matching

Manual Entry
The issues are divided into categories. Click on the applicable category, such as Mortgages
(Discharge/Assumed/Remaining/Postpone).

A new window will appear with specific issues related to the selected category. As you hover over
TitlePLUS specific issues (on the le� side), text will appear on the right side.

Click on the appropriate issue name. A new screen will open, the Issues WorkBench. This is meant to
be used for assisting in creating your documents, such as inquiry letters and undertakings. The Issues
WorkBench brings in data from elsewhere in the file (or Title Search) and provides text for your
reports, closing checklist, etc. for the particular issue.
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You have the ability to edit the default text and add your own (right click the clause you want to save
and select Save current text as new clause in the clause list).

Each issue works in a similar manner.

Title Search Matching using Teranet Connect
Alternatively, you can use the matching feature on the Title Search tab a�er you have completed the
initial title search (for how to complete a title search, please refer to our full RealtiWeb Title Search
Guide: https://www.lawyerdonedeal.com/rplus/ON5/pdf/TitleSearchUserGuide.pdf). Specifically, refer
to Activate Instruments in RealtiWeb Issues List (page 15) as it is the most relevant for importing
Teranet Connect search results into the Issues List.

If you return to the Issues tab, you will see the created issue. The name of the issue will use the type of
issue, instrument number (from Teranet Connect), and the registered date.

Carrying out actions from the Action List
The Action List changes dynamically based on the specific actions to be carried out for the specific
issue. There are a possibility of 9 items:

● Letter Inquiry
● Requisition
● Checklist
● Reporting Letter
● Undertaking
● Adjust/Payout

● Calendar
● TitlePLUS - only appears if TitlePLUS is

part of the deal
● Similar Name - only if outstanding

Executions

Majority of each item listed in the Action List has a corresponding document. Clicking on an item in
the Action List will change which clause you are editing.

Clauses
Each clause consists of the description and action clause.

The data fields in the text will be completed if the data has been entered throughout RealtiWeb or
from the title search import. You may overwrite the text if needed. If manually entering an issue, the
issue may have additional fields to be completed.

If you right click on the clause, you will see the various editing options for the text. This is what the
various options do:

Cut The text is removed from the clause and able to be pasted
elsewhere.

Copy This copies the text to your computer’s clipboard.

Paste This pastes the text on your computer’s clipboard (with no
formatting) to the clause.
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Paste with Format This pastes the text on your computer’s clipboard with
formatting.

Insert Defect Field A popup window will appear with a list of possible fields. These
fields will pull data previously entered into the file in the clause.
When the field is updated, the clause will also be updated.

Select all in text box This will select all text in the clause. It is useful if you want to
copy/remove the full clause text.

Restore to LDD default Selecting this will return the clause back to LDD’s standard
clause text.

Select another clause Clicking this will open your firm’s Favourite Clause database
(also accessible by using the database button).

Save current text as default This will overwrite the current default clause with the currently
selected clause for the document. If you open another file with
the same issue, then the clause for your document will not be
the LDD standard clause text. Instead your saved default clause
will be used for the document.

Save changes of current
text in clause list

This will update the clause text in your firm’s database.

Retrieve Default This will return the clause to its saved default version.

Note: This is the default version for your firm account, and could
be different from LDD’s standard default clause.

Save current text as new
clause in clause list

This will save the clause as a new clause in your firm’s database.

Remove this clause from
the list

This removes the clause from your firm’s database.

Dra�ing Documents
If there is a corresponding document for the action available, a blue Create Document will be near the
bottom of the Action List. The blue link will state the document that will be merged for viewing. For
example, clicking the Create Document - Checklist will merge the Checklist document.

Adjust/Payout and Calendar Action
The Adjust/Payout item will let you determine how to include the adjustment (or payout) in the
Statement of Adjustments or Trust Statement. There may be additional fields to be completed. The
Calendar item allows you to add a reminder to your RealtiWeb Calendar.

Inquiry Status, Requisition, Checklist, and Report tabs
These enable you to manage the issues:
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● Inquiry Status: function to manage non-title inquires, such as a mortgage discharge
● Requisition: view custom additions to the Requisition letter
● Checklist: view items added to the standard Checklist
● Report: view the added text to the standard Report

Financial Button
Here you are able to review and modify the financial information related to the file, under the six tabs:
Stmt of Adjustments, LTT, LTT Refund, Account to Client, Trust Statement, and Closing Funds
Summary. At the top of the page for each tab, there is a blue link to create the relevant document.

Statement of Adjustments
Consideration and Deposits come from information entered in the Basic button → Contract tab. The
Consideration is calculated based on the contract price.

Click Add to add further required adjustments. Click the dropdown menu to show the list of possible
adjustments to add.

As an example if you select Property Taxes, in the popup that appears and you can complete the Tax
Adjustment.

LTT
This tab is intended for calculating the fees associated with the Land Transfer Tax including any
refund/rebate your clients are entitled to. If your purchasing client qualifies for the LTT refund, please
indicate he/she is entitled on the Purchaser/Title Information popup (refer to the next section on LTT
Refund tab).

The LTT is completed based on the Purchase Price in the Basic button → Contract Details tab.

Document Control dropdown sets the LTT Form for the transferee or agent/solicitor to sign the
document. For a completed LTT Form address the statements by checking off the applicable
checkboxes, and editing the transferor and transferee details.

If your clients are subject to the Non-Resident Speculation Tax, please use the NRST checkbox.

Note: The LTT form does not export to Teranet (e-reg), it needs to be manually completed in the
e-reg system.

If the subject property is in Toronto, then Toronto’s Municipality Land Transfer Tax (MLTT) is added to
the tax total.

LTT Refund
If your clients are first time home buyers and entitled to the Land Tax Refund, that information is
added on the Transferee(s) popup (found under the Basic button → Basic Information tab).
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If you have checked off the above checkboxes, the applicable refunds will be shown on the LTT Refund
tab. If land transfer tax is included in your trust statement then the applicable refunds will also appear
there.

Account to Client tab
The Account to Client tab is intended to show you what is being charged for fees and disbursements,
and if applicable how much of the account is being paid from the trust.

Note: Firm settings can impact this tab and what is shown based on the firm settings setup.

Review the Auto Include? box in the Financial Functions box on the right of the screen. Anything
already checked off, is from your firm settings. If you check or uncheck an item, then the item will be
added or removed from the Account to Client.

Note: Any changes here will only be for this file and will not impact other files.

If one of the accounting integrations is enabled for your firm (PCLaw or CosmoLex), then you will see
an area for enabling the export and the necessary fields. For more information please see the
Accounting Integration guides.

Trust Statement
The Trust Statement brings in data from several places in the RealtiWeb file. The Paid section is filled in
from several locations. For example, the Balance Due on Closing is taken from the Statement of
Adjustments tab, the Land Transfer Tax is from the LTT tab, and the Statement of Account is from the
Account to Client tab.

Meanwhile, the Received section completes any received amounts from the Mortgage Advance from
the Mortgage Screen. Any additional funds from the client will need to be entered manually here.

Other items from previous tabs can be included when applicable. To manually add other items you
can, either type in the text box, click the database button for preset options, or the edit button. The
edit button will open the following screen and allow for manual entry.

Closing Funds Summary
The Balance Due on Closing is carried over from the Statement of Adjustments.

If there is a mortgage, then the mortgage amount will populate from the Mortgage Advance from the
Mortgage screen.

The estimated fees, disbursements, etc are inserted from the Account to Client tab.

Note: Amounts entered into the Closing Funds Summary will not go into any of the previous tabs.
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Docs Button
On the Docs button you can create the letters and documents you need for your real estate
transaction. Each document pulls information from the RealtiWeb file.

Document Control Items
Before you print (or send) a document for signing you may want to change the date, signing location,
and/or delivery notation on the document. The chevron beside the Document Control Items heading,
will expand to show the full array of controls.

The settings here are completed based on your firm settings, and can be modified for the specific file.
The Document Date defaults to the date the document was merged (a.k.a. created). The Use
Electronic Signature? checkbox will e-sign your documents as the lawyer on file, using
LawyerDoneDeal’s e-signing technology.

Document Organization
There are three ways to view the available documents listed: Category, Alphabetically, and Package.

The documents have been sorted by LawyerDoneDeal into categories and packages. You may click the
radio buttons to switch the sorting by Category, Package or Alphabetically.

The packages are designed to quickly generate documents into one. Simply right-click a package
name to see the potential options.

Searching for a Specific Document
If you have an idea of the document title, enter the title into the filter box. This will filter the available
document titles and show you all the documents with the entered word(s) in the title.

Document Merging Tool
As you are merging documents, you will be able to keep track of which documents are defaults of
RealtiWeb, your own custom documents and which documents were merged. The Document Merging
Tool is to help remind you of the colour legend and manage your document merging.

Document Colour Legend
The colours of the document names relate to the type of document. The Document Colour Legend is
always available on the right-side of the Docs screen. Simply click the black chevron beside the text to
expand/collapse the legend.

Note: Any document names that are listed in italics are PDF files and are maintained by
LawyerDoneDeal.

Multiple Document Merging
This feature is designed to allow you to merge several documents at the same time. Hold the Ctrl key
(on your keyboard) and click the documents in the list. The document names selected will appear in
the Document Merging Tool under the Multiple Document Merging heading.
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If you want to remove a document, then hold the Ctrl key and click the document in the list again.

The four buttons are:
● Post: This will initiate posting the selected documents to the other side’s lawyer.
● Merge: This will generate the chosen documents.
● Clear: This will deselect the chosen documents.
● More: This opens a list of options available. Specifically, useful if you want a group of

documents to be emailed or saved as an MS Word or PDF file.

Creating Documents
A�er finding the document you want to dra�, click the title and it will merge the document in a new
window. On the main Docs button screen the file will have a green checkmark at the end of the name.
If you click the green checkmark, you will be able to see the history of the document.

Editing documents
You can edit the document from the opened window, similar to how you edit a MS Word document. If
you right click a clause, you will see additional editing options.

If you want to change the text of a clause, double click the clause. This will open with a border around
the section the clause is in. You can start typing your changes. Once finished, click outside of the
bordered section.

Note: If you do not click outside of the box before saving or printing, the box lines will be frozen in
your file. To remove the box lines, you will have to restore the document back to its default. You will
lose all your changes.

Saving and Printing Documents
The top of the opened document will have the following options: Save, Save As, Print, Print Preview,
Share, PDF, MS Word and OpenOffice.

The Save option will freeze your document in the RealtiWeb file. This will prevent the specific
document from updating as more information is added to the RealtiWeb file. The Save As option will
allow you to save a different version of the document using a name you decide. All saved documents
will have a document icon at the end of the title in RealtiWeb.

The Share allows you to email the document (up to 5 people) or post to LDD’s Web Document
Retrieval to other lawyers.

The options PDF, MS Word and OpenOffice allow you to open and/or save a version of the document
in the respective program.

Specialty Tools
Label/Envelope/Fax
The Label/Envelope/Fax button will easily produce labels, envelopes and fax cover sheets for your
files. This uses contact information in a file to create the labels, envelopes and fax cover sheets you
require.
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If you change the contact information in RealtiWeb, the information will automatically be updated
here. You may add additional parties that are not in RealtiWeb, by adding their name under Extra
Contacts.

If you want more details, please see our guide accessible from the Help button (beside the Setup
button).

OREA Forms
If you have subscribed to the OREA Standard Forms with LawyerDoneDeal, you will be able to
complete your transaction from the creation of your Agreement of Purchase and Sale to finishing your
Final Reports a�er the close of your transaction all using RealtiWeb. If you click on the button OREA
Forms and you have subscribed you will see a popup window, allowing you to complete the pertinent
details of your Agreements, Schedules, etc.

The forms will pre-populate with information you have entered into your file and you may add other
clauses, etc to your agreement from the OREA forms area. All the standard OREA clauses with regard to
conditions, mortgages, etc are available through LDD. These documents are trademarked by the
Ontario Real Estate Board and are available to LDD users for the yearly license fee charged by OREA.

If you click on the OREA Forms button and receive a popup message indicating you are not
subscribed, clicking “OK” will send you to a new page where you can subscribe to the OREA Standard
Forms through LawyerDoneDeal. To subscribe to the OREA Standard Forms, click Purchase to start the
process of subscribing.

Title Insurance Button
On the Title Insurance button, select the title insurance provider for the transaction, or select “N/A”.
This is where title insurance provider details are accessed in RealtiWeb. Refer to our title insurance
page for help.

Uploading to Teraview and Teranet Express
RealtiWeb allows exporting information from your file into Teraview and Teranet Express. Someone at
the firm with administrative rights should save the firm’s Teraview account name and TV number
under 3rd Party Account Information in Firm Settings. Individual users of the firm should save their
Teraview credentials under their User Settings (under the Tools dropdown menu across the top).

Prescribed Information for the Purposes of Section 5.0.1
Form Info to Teranet Express
If the Teraview account name and TV number of the firm are saved under Firm Settings, then
RealtiWeb will log into Teranet Express and create/access the Prescribed Information for the Purposes
of Section 5.0.1 Form (PIPS).

In the file you want to create the PIPS form for, click on the chevron next to the Basic button and click
Export to e-reg to open a popup. In the popup, click the Create button beside PIPS Form.
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Teranet Express will open, and RealtiWeb will go through the process of uploading the applicable
information, including PIN(s), Transferee(s) (Individuals or Corporations), and Date of Birth.

You will then complete the form as required on the Teranet Express site.

The Form ID field (on the Export to e-reg popup) will automatically come in from Teranet Express.

Note: Remember to save your file a�er clicking Create.

If you have not yet submitted the form, clicking on the Open PIPS button will launch the Teranet
Express and bring you the correct form (assuming the Form ID is filled in).

Upload Transfers, Charges/Mortgages, Discharges and
Document Generals to Teraview
RealtiWeb has the ability to export to Teraview, accessed from the Export to e-reg menu option under
the Basic button dropdown.

Important: Go to User Settings (under the Tools menu) to set up your Teraview credentials before
trying to upload to Teraview.

When you are ready to send information to Teraview. Click Export to e-reg from the Basic button
dropdown menu (accessed by clicking the chevron beside the Basic button).

In the Export To e-reg popup, it shows the Docket ID, Docket Name and LRO # fields for the docket in
Teraview. These can be changed as necessary.

Select the instruments and document general items you want to send to Teraview. For example, the
transfer, charge(s), discharge(s) or any of the numerous document general options available in
RealtiWeb.

A�er selecting what to send to Teraview, click on the TVWeb button. This will open a new browser
window with Teraview loaded. RealtiWeb will go through the process of uploading everything
selected.

When RealtiWeb is finished, there will be a notification that it’s finished. However, Teraview is still
updating. You can check the status of your upload in Teraview under Projects.

Note: Record the Request ID number from Teraview for future reference.
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Further Help and Support
We want to ensure your complete satisfaction with our products. Should you have any questions or
experience any problems or difficulties with using RealtiWeb, please do not hesitate to contact our
Support team. You can contact us as shown below:

Phone 800-363-2253 ext. 0
416-367-0600 ext. 0

Email support@ldd.ca
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